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Objective: Learn the basic operation of the computer program SeisVolE – an effective 
tool for exploring earthquake and volcano occurrences and plate tectonics.  The SeisVolE 
computer program (written and distributed by Prof. Alan Jones, State University of New 
York, Binghamton) can be easily downloaded and installed (see teaching module 1) on 
your computer and then used to view “speeded-up-real-time” displays of earthquake and 
volcano activity on a variety of base maps.  The program is powerful and easy to use and 
allows one to view many pre-assembled maps (views) or to select a new view and control 
the display.   
 
Information: The SeisVolE program contain extensive earthquake and volcanic 
eruption data files (catalogs), and can be updated from the Internet to include the 
most recent earthquake information.  Additionally, information on individual events can 
                                                 
 Copyright 2001.  L. Braile and S. Braile.  Permission granted for reproduction for non-commercial 
purposes. 

File  
    Control 
         Earthquakes 
             Eruptions 
                  Map 
                      Options 
                           Help 
                                Exit 



2.  SeisVolE basic navigation…                      Page 2 of 6 
 

Seismic/Eruption Teaching Modules:                        2 - 2 - 

be obtained and statistical analyses can be performed on the earthquake or eruption data 
by controlling the time, area and magnitude ranges of the display.  The earthquake 
catalog (world.hy4) contains hypocenter (the hypocenter is the epicenter location and the 
depth of focus) information (latitude, longitude, depth, origin time, magnitude) for 
worldwide events of magnitude 5.0 and above for 1960 to the present.  The catalog also 
includes earthquakes of magnitude 4.0 and above for the United States and of magnitude 
3.0 and above for California.  Hypocenter data can be updated to include current events 
through connection to the Internet (see Teaching Module 13).  Additional catalogs can 
be created for specific areas and for additional time or magnitude ranges using 
earthquake searches available on the Internet and then plotted and analyzed using 
SeisVolE.  The volcanic eruption catalog contains eruption data for 1960 to early 2000.  
More information on the volcano data, including a discussion of estimation of the 
magnitude (size) of volcanic eruptions, is contained in the Help file of SeisVolE. 
 
The program is very useful and produces attractive maps.  It is worthwhile to have 
individual students use the program in a computer lab or with their own computers.  
Alternatively, the program can be used in demonstration mode in a classroom to illustrate 
interesting and important earthquake and plate tectonic concepts.  The seismicity maps 
can be displayed for large and small areas (for example the world display in Figure 2.1 or 
the view of California and Nevada in Figure 2.2). 

 

Figure 2.1  Screen image of the SeisVolE display for worldwide earthquakes and volcanic 
eruptions from 1960 to 2000.  Dots are epicenters.  Triangles are volcanoes.  Heavy colored lines 
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are inferred plate boundaries.  The Key provides color-coded information on earthquake and 
volcanic eruption magnitude and earthquake depth.  Counters provide information on numbers of 
events in the map area over the selected period of time.  This information can be used for 
statistical analysis of earthquake and volcano activity.  Buttons (near the bottom of the screen), 
pull-down menus (not shown, at top of screen) and a slider provide display control and 
information about the earthquakes and eruptions. 
 

 

 
Figure 2.2  SeisVolE map (extracted from screen image) of California and Nevada showing 
earthquakes from 1960 to 2000.  Base map illustrates topography.  Dots are earthquake 
epicenters.  Dot size is proportional to magnitude of the event.  Blue lines are faults. 
 
Basic Operation of SeisVolE:  SeisVolE has many options that allow the user to 
control the data that are displayed and the appearance of the maps that are produced.  A 
“help file” (from the pull-down menus at the top of the screen) provides detailed 
information on the program, data files and operation.  An auxiliary DOS program 
(EQSELECT, see Help, Contents) is available for searching the earthquake data file.  
Some basic operation options and information are: 
 

Views – Use the buttons on the screen to select pre-assembled maps.  The Back 
button will return you to the menus of views.  You can create your own views 
with the “Make Your Own Map” option under the Map menu. 
 
Key – The map key on the right side of the screen (Figure 2.1) provides 
information on the earthquakes and eruptions that are plotted, including a counter 
that can be useful for analyzing the statistics of earthquake and eruption 
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sequences.  Symbol sizes, ranges and colors can be changed from the 
Earthquakes and Eruptions pull-down menus. 
 
Playback Control – Buttons and a slider bar for controlling the display of the 
earthquake and eruption data through time are provided at the bottom of the 
screen.  You can turn the display of earthquakes or eruptions on or off, adjust the 
speed of the playback (speeded-up-real-time), the magnitudes that are displayed, 
and control the playback with buttons (Pause, Repeat, Rewind, etc.) and a slider 
control, similar to the operation of audio equipment.  The Step buttons allow you 
to step through the data (forwards or backwards) one event at a time and see the 
information on that event (location, origin time, magnitude; earthquake or 
volcano) on the screen.  This feature is very useful for identifying a specific event 
in the earthquake catalog or finding the event that is closest to a specific time or 
location. 
 
Menus – The pull-down menus at the top of the screen provide additional 
control of data that are displayed and map appearance.  Figure 2.3 shows the 
selection screen that is displayed at the beginning of the SeisVolE program.  
Standard views are opened using the buttons.  Various controls and options of 
standard views and views generated by the user are selected using the pull-down 
menus (at the top of the screen, for example in Figure 2.3). 
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Figure 2.3.  Selection screen at the beginning of the SeisVolE program.  Pull-down menu items 
are shown on the upper line (File, Control, etc.). Selection buttons (Asia Group, Pacific Group, 
etc.) allow opening of standard views. 

 
 

You can Set Dates (range of dates; useful for analyzing statistics of sequences or 
finding an event of interest) of the events to be displayed from the Control menu.  
The Earthquake menu allows one to view the event catalog.  The Map menu 
allows you to see the range of latitude and longitude that is included in the view 
and to make your own maps to “zoom in” on an area.  The Options menu allows 
you to display the coordinates (latitude and longitude) of the cursor so that 
individual locations may be determined, to make a bitmap image of the screen 
that can be plotted or exported to another file, and to update the hypocenters 
(earthquake data) from the Internet (this capability is very useful as it allows you 
to display the location of a very recent local earthquake or large earthquake or any 
event of interest and to see its location in relation to the historic seismicity.  
Specific menu items (at the top of the screen) of most interest include: 
 
File – The File menu allows one to select various views although the views can 
also be accessed by the buttons on the screen and the Back button.  Additionally, 
if you generate a new view by changing the control, earthquake or eruption 
information or by the Make Your Own Map option (Map menu), you can save 
that view for later access by using the Save as option. 
 
Control – The Control menu allows you to set the dates (Set Dates) for the data 
to be displayed and the and Speed of the playback (speed can also be set using the 
button control at the bottom of the screen).  The Map View and Set Up Cross-
Section View controls are useful for viewing the earthquake data in a cross-
section view.  For details on using these controls, see Teaching Module 14. 
 
Earthquakes – The audio output associated with each earthquake can be turned 
on or off with the Audio control.  The Earthquake menu allows one to select the 
appropriate earthquake catalog using the Earthquake File control.  Generally, the 
world.hy4 catalog is already selected and is the appropriate catalog to use.  
However, if one creates a new catalog for a specific region, one can select it for 
the current view using the Earthquake File control.  Data in the earthquake 
catalog can be displayed and read using the Edit Earthquake File… menu item.  
The Magnitude/Depth Scale control is also useful to set the color-coding of the 
earthquake depths and the size of the dots for adjusting the appearance of the 
display. 
 
Eruptions – The Eruptions control includes an on/off control for the audio 
(Audio) associated with the eruptions and control of the Volcano Names display. 
 
Map – The Map controls of most use are:  Latitude/Longitude – to set  (or 
check) the latitude and longitude range of a view; Annotations – to add 
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geographic and text information (Title, Scale, City names, etc.) to a map display; 
Shaded Terrain – to select the elevation file for a shaded terrain topographic 
map, particularly for the Make Your Own Map option; Make Your Own Map – 
to select an area on the current view to make you own map – using this option, 
one can “zoom in” on a specific area to view the earthquake and volcano activity 
– shaded terrain can be added to the make your own map views using the 
elevation files; Plates – controls optional display of plate boundaries; Redraw – 
to redraw the map after a new elevation file has been selected. 
 
Options – useful controls include: Coordinates – to display the latitude and 
longitude of the cursor location; Make Bitmap – to produce a bitmap image of 
the current view that can be copied or inserted into another document such as a 
Microsoft Word file (when you have a screen display that you’d like to save, 
select Make Bitmap from the Options menu; you will be prompted to provide a 
file name which will be given a file extension of .bmp, which stands for bitmap; 
the file will be stored in your SEISVOLE folder; you can open the bitmap image 
with a photo processing program such as Adobe Photo Deluxe, or import into an 
MS Word document by selecting Insert, Picture, From File…; then “navigate” 
to the SEISVOLE folder to select the .bmp file that you saved); Update 
Hypocenters via Internet – using this option, you can automatically update the 
earthquake data file with recent hypocenters (your computer must be connected to 
the Internet when you select this option). 
 
Help – Access to the SeisVolE help files for additional information on the 
earthquake and volcano data, operating SeisVolE and the DOS programs for 
importing and exporting earthquake data. 
 
Exit – To exit SeisVolE. 

  
Summary:  Working with SeisVolE is interesting and educational.  The program 
allows one to make attractive maps of historic and very recent earthquake and volcanic 
eruption data and to investigate the temporal and spatial distributions of earthquakes and 
eruptions.  For many demonstrations, investigations and activities, the standard views and 
the controls that are readily available on the screen are all that are necessary to effectively 
use SeisVolE to explore earthquake and volcanic eruption activity and related plate 
tectonics.  However, to investigate specific areas, events or phenomena, or to conduct 
independent research projects, many of the controls and options that are described here 
will be either useful or necessary. 
 
 
Go to List of SeisVole Teaching Modules (in Introduction to SeisVolE 
Teaching…; Module 0) 
 
 


